
Input Panel Options
The following graphics are the tab windows where you can customize the input panel to your preferences.

Input Method tab Word Completion tab Options tab
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Writing on the Screen

In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can 
use your stylus to write directly on the screen as you would on paper. You can edit and format what you’ve written and convert 
the information to text at a later time.

To write on the screen, tap the Pen button to switch to writing mode. This action displays lines on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how 
to switch to writing mode.

To select writing
If you want to edit or format writing, you must select it first.

1 Tap and hold the stylus next to the text you want to select until the insertion point appears.

2 Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. You can also select text by tapping the Pen button 
to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold the selected words and then 
tap an editing command on the pop-up menu, or tap the command on the Edit menu.

Tap the Pen button and use
your stylus like a pen.
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Convert Writing to Text
To convert writing to text, tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping Recognize on the Tools menu (or tap and hold the selected 
words and then tap Recognize on the pop-up menu). If a word is not recognized, it is left as writing.

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.
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Alternate words
If the conversion is incorrect, you can select different words from a list of alternates or return to the original writing. To do so, tap 
and hold the incorrect word (tap one word at a time). On the pop-up menu, tap Alternates. A menu with a list of alternate words 
appears. Tap the word you want to use, or tap the writing at the top of the menu to return to the original writing. 

Tips for Getting Good Recognition
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and apostrophes below the top line so that 

they are not confused with the word above. Write periods and commas above the line.
• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so that the device can easily tell where words begin and 

end.
• Hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to recognize the word, the writing 

you add will not be included if you attempt to recognize the writing again. 

Or, tap the word you want
to use.

Tap to return to your
original writing.
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Drawing on the Screen

Drawing on the screen is similar to writing on the screen. The difference between writing and drawing on the screen is how you 
select items and how they can be edited. 

To create a drawing, cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching the 
drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

For example, selected drawings can be resized, while writing cannot.

Note: You may want to change the zoom level so that you can more easily work on or view your drawing. Tap Tools and then 
a zoom level.

Selecting a Drawing
To edit or format a drawing, tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, 
deselect the Pen button and then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and then tapping an editing 
command on the pop-up menu, or by tapping the command on the Edit menu. To resize a drawing, make sure the Pen button 
is not selected, and drag a selection handle.

The drawing box indicates
the boundaries of the drawing.

Pen button.
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Using My Text

When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used messages into the text entry area. 
To insert a message, tap My Text and tap a message.

Note: You can add text after inserting a My Text message before sending it.

To edit a My Text message, in the Tools menu, tap Edit and then tap My Text Messages. Select the message you wish to edit 
and make desired changes.

Tap to select a
prewritten message.

Using My Text
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Today Screen

When you turn on your device for the first time each day (or after 4 hours of inactivity), you’ll see the Today screen. You can also 
display it by tapping Start and then Today. On the Today screen, you can see at a glance important information for the day.

Your day at a glance.

Tap to create a new item.

Tap to switch
to a program.

Tap to view notification messages.

Tap to view connection status.

Tap to change date and time.

Tap to open an item.

Tap to change volume or mute all sounds.

Today Screen 
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Status Icons

Note: If more notification icons need to be displayed than there is room to display them, the Notification icon, , will display. 
Tap the icon to view all notification icons.

Status Icon Meaning

Turns all sounds on and off 

Backup battery is low 

Main batteries are charging 

Main batteries are low 

Main batteries are very low 

Main batteries are full

Connection is active 

Synchronization is beginning or ending

Synchronization is occurring

Notification that one or more instant 
messages were received

Notification that one or more e-mail 
messages were received
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Selecting Programs

To select a program, tap Start > Programs, then the program name. 

Note: Some programs have abbreviated labels for check boxes and drop-down menus. To see the full spelling of an abbreviated 
label, tap and hold the stylus on the label. Drag the stylus off the label so that the command is not carried out. 
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Navigation Bar and Command Bar

The navigation bar is located at the top of the screen. It displays the active program and current time, and allows you to switch 
to programs and close screens. 

Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes menu names, 
buttons, and the Input Panel button. To create a new item in the current program, tap New. To see the name of a button, tap and 
hold the stylus on the button. Drag the stylus off the button so that the command is not carried out.

Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For example, you can use the pop-up menu in the contact list 
to quickly delete a contact, make a copy of a contact, or send an e-mail message to a contact. The actions in the pop-up menus 
vary from program to program. To access a pop-up menu, tap and hold the stylus on the item name that you want to perform the 
action on. When the menu appears, lift the stylus, and tap the action you want to perform. Or tap anywhere outside the menu to 
close the menu without performing an action.

Notifications

Your device reminds you in a variety of ways when you have something to do. For example, if you’ve set up an appointment in 
Calendar, a task with a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your device. 

To choose reminder types and sounds for your device, tap Start>Settings>Personal tab>Sounds & Notifications. The options 
you choose here apply throughout the device.

Tap to select a program.

Tap to change volume or mute the device.

Tap to see additional programs.

Tap to customize the device.

Tap to quickly select a program
you have recently used.

Screen Navigation
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Finding and Organizing Information

The Find feature on your Dolphin mobile computer helps you quickly locate information. On the Start menu, tap Find. Enter the 
text you want to find, select a data type, and then tap Go to start the search.

To quickly find information that is taking up storage space on your device, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device and to organize these files into folders. On the Start menu, tap 
Programs, and then File Explorer.

You can move files in File Explorer by tapping and holding the item you want to move, and then tapping Cut or Copy and Paste 
on the pop-up menu.

Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.
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5

D

Wireless Communications with Dolphin 9500/9550 
Wireless Local Area Network (WLAN) Communications
Dolphin 9500/9550 terminals are available with an on-board 2.4 GHz 802.11b WLAN radio that uses Direct Sequence Spread 
Spectrum (DSSS) technology to spread the signal continuously over a wide frequency band. It provides a data rate of up to 11 
MB per second. In addition, the open software architecture make the Dolphin 9500/9550 a complete solution for a variety of 
wireless mobile data collection applications.

Dolphin 9500/9550 is interoperable with other 802.11b WiFi®-compliant products including access points, printers, PCs via PC-
card adapters and other wireless portable terminals.
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Choosing a Radio - the Radio Manager 

Purpose

The Radio Manager is a control panel applet in the system through which the radio power driver controls the radio state. It 
enables you to choose which radios in the terminal are powered up. When powered up, the radio is transmitting, when powered 
down, the radio is not transmitting.  

SIngle radio configuration

If your terminal contains a single radio and its associated driver is installed, the radio operates by itself without any special 
configuration made to the device. You can use the Radio Manger to power it down. 

Potential radios

There is a potential for three radios to be installed in the device:

• Bluetooth, 
• 802.11b, and 
• GSM/GPRS. 

Multiple radio configuration

If multiple radios are installed in your terminal, simultaneous operation must be configured on the device before the radio power 
driver allows it. Configuration of simultaneous radio operation is done during the manufacturing process according to FCC 
regulations. 

Multiple radio operation

GSM and 802.11b are mutually exclusive. While they may both be present, they cannot be allowed to operate simultaneously. 
The Bluetooth radio is allowed to operate by itself or simultaneously with either of the GSM or 802.11b radios.

Accessing the Radio Manager
Go the Start > Settings > System tab > Radio Manager. The Radio Manager appears identifying which radio modes are allowed 
in the Radio Modes box. The highlighted entry is the radio mode that is currently enabled; its Status should be Ready.   
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The Radio Modes box

The Radio Modes box displays the radios currently installed on your terminal. For example, if a working Bluetooth module is 
installed, the box contains the line BlueTooth Only whether or not that radio is currently powered up. (There may be other 
Bluetooth related list box entries, but the BlueTooth Only entry is guaranteed to be there if the module is present.)

Powering up a radio
Simply select an entry in the Radio Modes box and click Apply. The Radio Manager issues the radio power driver commands of 
enabling and disabling the radios in the proper sequence. 

For example, let’s say the current mode is BlueTooth Only and the attempt is made to switch to 802.11b Only. After Apply is 
clicked, the Radio Manager turns off the Bluetooth radio first, then turns on the 802.11b radio. 

If an error occurs at either step, the radio mode change is abandoned, and the resulting radio state returns to what is was at the 
time the error occurred. 

Requirements

To successfully power up a radio, its associated driver CAB must have been installed along with the module. If the module is 
present, the radio appears in the Radio Modes box; however if the associated CAB for that module is not installed, you cannot 
successfully enable the radio.

For instance, if the Bluetooth module is present but its CAB has not been installed, BlueTooth Only selection still appears in the 
Radio Mode box. However, attempting to power it up will result in an error in the Status field.

The Status field
The Status field displays error messages when a radio cannot be enabled. When is reads “Ready” the radio selected in the Radio 
Modes box is powered up.
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Configuring WLAN Communications 

To open the configuration utility for the 802.11b radio, click Start > Settings > System tab> HHP WLAN Settings . 

The Settings window opens to the Status tab, which displays the current WLAN settings for 802.11b. 

Status tab

Fields

Current Channel Shows the RF channel currently used by the card.

Current TX Rate Shows the current transmit rate. This can be 1Mb/s, 2Mb/s, 5.5Mb/s, or 11 Mb/s.

Link Quality Gives signal to noise ratio in both percentage and graphical display.

Strength Gives signal strength of the receiver in both percentage and graphical display.

Station IP Info IP Address - IP address of the radio. Check with your network administrator for IP configuration 
information. 

BSS ID/IBSS ID Shows the Network Name and the MAC address of the access point the card is associated with in the 
AP mode. Or it shows the Network Name and the MAC address of the creator of IBSS which the card 
is joined into in the Peer-to-Peer (Ad-Hoc) mode.

Operation buttons

Disable/Enable Radio Click this button in toggle to disable/enable the radio link from the card.

Rescan Click this button to start a rescan process to search for an AP with stronger signal in the network.

Renew IP Click this button to reapply IP address from DHCP server when automatic DHCP is enabled. 
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More Info Click this button to display detailed TCP/IP info; as shown in the following screen: 

Click OK to close this window.

Ping Click this button to open the Ping utility for WLAN.

Ping Utility for WLAN window field descriptions

IP Address Displays the current IP address. You can enter another IP address to ping. 

Size (Bytes) Displays the current bytes size; 32 is the default. You can select up to 8192 from the drop-down list.

Timeout (ms) DIsplays the current timeout; 500 is the default. Increase or decrease it by tapping the spin buttons.

Clear Click this button to clear IP Address input and the ping statistics field. 
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Ping Click this button to ping the IP address entered in the input field. 

Ping Statistics field: Shows the pinging IP address and the pinging results.

Config Tab
The Config tab provides a list of all access points and peer stations in range. Its configuration tool enables you to create and edit 
SSID profiles for access points that you want your station to associate with. 

Fields

Preferred Profiles A list of preferred profiles for access points (AP) in the network created by the user, or added from 
the Active SSIDs table is located at the top of the Config window. When the radio is turned on, it 
searches for the APs with which to associate in the order of the listed profiles. For each profile in the 
table, one can make changes by using the icon tools at top of the table: New, Edit, Delete, Up, and 
Down (Operation buttons on page 5-4). This table is blank after the initial HHP software installation. 
It can be kept blank with no automatic association preference.

Active SSIDs The Active SSIDs table lists all access points or peer stations (creator of IBSS) in the vicinity of the 
host. It displays only those SSIDs that accept broadcast associations.

Each record displays information for the following six fields (The table may not display all the fields 
on the screen. Use horizontal scroll bar to check all): 

 SSID - Network Name of the access point or peer station. A link icon with signal strength  is also 
shown.

 Signal Strength in percentage for that SSID.

Mode - An icon shows whether it is an access point , or a peer station .

Channel - The channel it uses and the WEP method it applies if any. The icon  stands for WEP 

Key-On, and  for WEP Key-Off.

SupRate - Supported data rate of the access point or the peer station.

BSSID (MAC Addr) - BSSID or MAC Address of the access point or the peer station.
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Operation buttons

Apply Click the Apply button to associate your station with the SSID you selected. 

This SSID can be either from the Preferred Profile table or from the Active SSIDs list. When applied, 
the Status tab window displays the status of the wireless connection. If the association failed, a 
search for another AP in the Preferred Profile list automatically takes place and the radio attempts to 
associate with the station, in order of preference.

Refresh Click the Refresh button to start a new search for all available access points or peer stations in the 
vicinity.

To add an Active SSID profile to the Preferred Profile table, complete these steps:

1 Select and highlight an SSID from the Active SSID list.

2 Click Add.
If the SSID has WEP Key-On, the Settings window displays and prompts you to enter the WEP Method, Encryption Key, and 
Key ID. 

3 Click OK in the Settings window after finishing the configuration. The SSID and its profile are added into the Preferred 
Profiles window. 
If adding an SSID with WEP Key Off, the Settings window does not display and the SSID is added directly to the Preferred 
Profile table when you click the Add button. 
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Creating and modifying profiles
Use the following five icons at the top of the window:    

To create and add a new profile to the Preferred Profiles list, complete these steps: 

1 Click the New button and the following screen displays:

2 Enter the values for the new profile in the information fields and click OK.

Icon Name Click this icon to…

New  create a profile.

Edit  modify a profile.

Delete delete a selected profile.

Up move the highlighted profile up to increase the automatic association priority.

Down  move the highlighted profile down to decrease the automatic association priority.
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To modify a profile, select one and click the Edit button. The following screen displays:

Note: The SSID, Type, TX Rate, and Channel fields are unchangeable in AP mode, whereas TX Rate and Channel fields can 
be changed in Peer-to-Peer mode.

Network Name & Type 

SSID To enter an SSID, which is the Network Name. Check with your network administrator for Network 
Name (SSID).

Type Choose from Peer-to-Peer or Access Point in the pull down menu. 

Access Point mode is also called “Infrastructure” mode. Peer-to-Peer mode is used for 
communication between two (or more) radio stations (cards) without an access point. 

TX Rate Choose 1Mb, 2 Mb, Auto 1/2 Mb, 5.5 Mb, 11 Mb, or Fully Auto from the menu. The transmit rate is 
Fully Automatic by default. 

Chan Channel. Scroll to select a channel for communication. 

WEP Used to configure the WEP Key for secure wireless communication. Within this block, you configure 
the WEP Method, Encryption Key, and Key ID. 

Use Manual Key Manually input the encryption code for the WEP Key. This is the default setting.

Use Passphrase Generates an encryption code based on the phrase entered in the window. Not available in this 
release.

Method Select one of the five options from the list:

Note: HEX, Hexadecimal number set of 16 digits from 0-9 and from A(a)-F(f). ASCII: Any printable ASCII characters.

Encryption Key Different character set depending on different WEP method and key format.

Key ID Choose from the available options: 

• Disabled WEP Key Off

• 64 bit (HEX) up to 10 characters configurable in Hexadecimal for Encryption Key

• 64 bit (ASCII) up to 5 characters configurable in ASCII for Encryption Key

• 128 bit (HEX) up to 26 characters configurable in Hexadecimal for Encryption Key

• 128 bit (ASCII) up to 13 characters configurable in ASCII for Encryption Key

• Key 1(Default)

• Key 2
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Check with your network administrator for security WEP Key and Key ID you need to use.

Cancel Click this button to close the window without saving or modifying the profile.

OK Click this button to make the change.

Deleting a Profile
Profiles may be deleted either from the Preferred List or from the Preferred List and Registry. To delete a profile, select (highlight) 
a profile and click the Delete button and the following screen displays:

From the pop-up window select the option of your choice and click Yes to confirm or No to cancel. 

Advanced Settings tab
On the Settings window, click the Advanced tab. The following screen displays: 

Information Fields

Power Save Mode

• Key 3

• Key 4
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• Disable - Choosing this option will disable the power save mode.
• Always Enable - Choosing this option will have the power save mode always enabled. This is the default setting.
• Auto Enable - When internal battery is being used it will be in Power Save mode; when external power supply is being used 

the Power Save mode will be disabled automatically.

Authentication Algorithm

Note: Only configurable when the WEP Key is enabled for the SSID profile.

• WECA Compliant (always use Open) - Not available in this release.
• Must use Shared with WEP - AP must use WEP method.
• Automatic based on WEP setting - Default setting.
• Preamble Mode
• Long TX Preamble - Where Sync field consists of 128 bits. 
• Short TX Preamble - Where Sync field consists of 56 bits.
• Auto TX Preamble - Automatically change between long and short preamble mode transmission based on the AP 

configurations. This is the default Preamble Mode.
A Preamble consists of a Synchronization (Sync) field and a 16-bit Start Frame Delimiter (SFD) field.

Operation Buttons

Defaults Resets all the settings to default values (Always Enable for Power Save Mode, Automatic based on 
WEP setting for Authentication Algorithm, and Auto TX Preamble for Preamble Mode).

Undo Cancels the change for setting.

Apply Applies the change to new card setting.

About Tab
This window provides Version Number and time of build for Network Driver, Configuration Utility, and NIC Firmware. 

On the Settings window, click the About tab. 
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Status Icon

You can access the configuration utility by tapping and holding on the Status icon  at any time. The following menu displays:

The four menu entries at the bottom correspond to the four configuration settings tabs: the Status, Config, Advanced, and About 
respectively. This side menu provides a shortcut to the configuration settings.

Wireless Radio On Turns on the radio. LED is on and the Link Icon displays with signal strength.

Wireless Radio Off Turns off the radio. A pop-up window will ask for your confirmation. If confirmed, the LED will be off 
and the Link Icon will change color from green to red on the top without signal strength displayed. The 
WLAN card/module will stop functioning. 

Remove Status Icon Removes the Status Icon from the Windows Status Tray. A pop-up window will ask for your 
confirmation. If confirmed, the Status (Link) Icon will be removed from the Windows Status Tray.

Wireless Network Status Opens the Status tab of the configuration utility

If the Status Icon changes to a crossed lock , it warns you that you may have entered a wrong key (WEP Key mismatch) for 
the WEP-On AP or a station.

Note: You can also go to Start > Programs > HHP WLAN Settings.

Remove Wireless Status Icon Window
If you choose to remove the Remove Status Icon, the screen shown below displays: 

Press Yes to confirm, or No to cancel. 

If confirmed, the Status Icon will not display in the Windows Status Tray. By checking “Remove Status Icon Permanently” at the 
bottom of the window you will not see the Status Icon even after your system has been restarted. Otherwise it will re-appear next 
time you turn on the system. 
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Wireless Personal Area Network Communications with Bluetooth

Setting up Your Bluetooth Card
Note: If you use the Get Connected! Wizard, which is recommended for normal usage, then this step is not necessary. This step 

would be used to change the friendly name of your mobile computer.

1 Tap the Bluetooth icon that appears in the task tray .
If you installed OBEX, the menu will also list Transfer via Bluetooth.

2 In the pop-up menu, select Advanced Features, then My Bluetooth Device.

3  In the My Bluetooth Device screen, you can modify the Friendly Name and make any desired configuration changes. 
When done, tap OK.

• In normal phone connect operation, Discoverable mode is not needed and should be disabled.
• If you do enable Discoverable mode (e.g., for ActiveSync), note that it does not shut off by itself. To save power, remember 

to disable it when not needed. 
• Connectable, Use Authentication, and Use Encryption are also not required for printing or dial-up networking applications.
• Check Use Authentication to enable the Use Encryption option.

Assign COM Ports
Follow these steps to view and/or modify the Bluetooth COM ports. 

1 Tap on the Bluetooth icon on the Today screen. Select Advanced Features then My Bluetooth Device.

Note: If you installed OBEX, the menu will also list Transfer via Bluetooth.
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2 The My Bluetooth Device screen will appear. Tap on the COM Ports tab.

3  As needed, view and/or enable/disable the Bluetooth COM port assignments. Tap OK. 

Note: The Bluetooth Phone port cannot be disabled. For more information about COM ports, see the Com Port Assignment 
Table on page A-12.

Discover Bluetooth Device(s)
Follow these steps to discover other Bluetooth devices nearby, including non-phone devices. The Device Discovery Wizard is a 
more detailed alternative to using the Bluetooth “Get Connected!” Wizard or Bluetooth ActiveSync or Bluetooth LAN Access 
options. The Device Discovery Wizard allows you to discover any type of Bluetooth device.

1 If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced 
Features then Bluetooth Devices.

2 In the Bluetooth Devices Folder, tap on the Device Discovery icon. Or you can tap on Tools. In the pop-up menu, select 
Device Discovery.
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3 Follow the Bluetooth Device Discovery Wizard to search for Bluetooth devices nearby. When prompted, select the device 
type you seek.

4  When the search is complete, a screen will report the discovered Bluetooth devices. Check the box next to any device you 
wish to save information about, (i.e., any devices you wish to connect to). Tap Next>.

5  A service discovery phase will begin, 5-10 seconds per chosen device.

6 In the next screen, tap Finish.

Bond with Discovered Device(s)
Follow these steps to bond with an already discovered Bluetooth device. In most cases, bonding is for establishing secure 
communications with a Bluetooth-enabled phone. This is a more detailed alternative to using the Bluetooth “Get Connected! 
Wizard.”

Important!

• Do not try to bond with a Motorola Timeport 270C or Nokia 6310!
• Do not use this method to bond with a printer! The third-party printing software included on the installation CD also handles 

bonding.
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1 If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon in the Today screen. Select Advanced 
Features, then Bluetooth Devices.

2 Tap and hold your stylus on the Bluetooth device you want to bond with. In the pop-up menu, select Bond.

3 Alternatively, after selecting a device, tap on the Bond icon. Or tap on Device, then select Bond.

4 The Bluetooth Device Bonding Wizard will launch. Follow the wizard to bond with your selected device. 
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5 As prompted, make sure the Bluetooth device that you want to bond with is in Bondable mode.

6 If the remote device is set up to accept bonding, a Bluetooth Passkey screen will appear. To continue bonding, enter the 
correct passkey and tap Reply.

7 When you have successfully bonded with the other device, tap Finish.

View Device Properties
Follow these steps to view the properties of an already discovered device. 

1 If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced 
Features then Bluetooth Devices.

2 Select a device. Tap on the Properties icon, or tap on Device then select Properties. Alternatively, you can tap and hold 
your stylus on the Bluetooth device you want to view information about. In the pop-up menu, select Properties.
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3  Use the General and Services screens to research device properties. If needed, assign a new device type icon by tapping 
on the arrow buttons in the General screen. You can also use the Device name field to rename the device. When done, tap 
ok for the setting to take effect.

Set up Your Favorite Device
Follow these steps to set up default devices in the Bluetooth Devices folder. 

Note:  The Get Connected! Wizard automatically assigns the favorite phone.

Complete these steps:

1 Tap on Tools and select My Favorites. 

2 Tap on the tab for the type of device you would like to set a favorite for. If needed, use the arrow buttons to scroll and find the 
tab you need.

Note: Tabs will appear only for COM ports you have enabled. To enable a port, refer to the “Assign COM Ports” section earlier 
in this chapter.

3 To select a favorite device, select Use the favorite selected above. In the drop-down menu, select your device. Tap OK.

4 After setting a device as your favorite, its icon will appear in the Bluetooth Devices folder with a heart next to it.

Change Views
You can switch between the Large Icons or Details views for the Bluetooth Devices folder.
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1 In Bluetooth Devices, tap on View.

2 In the pop-up menu, choose between Large Icons or Details.

Note: In Details view, scroll right to see the current Bonded status.

Large Icons view

Details view
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Delete a Device from the Folder
If you no longer plan to connect with it, you can delete a device from the Bluetooth Devices folder. 

1 If not open, launch the Bluetooth Devices folder.

2 Tap and hold your stylus on the device you wish to delete. In the pop-up menu, select Delete.

3 Alternatively, after selecting a device, tap on the Delete icon. Or tap on Device then select Delete.

4 A Confirm screen will appear. Tap Yes.
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Turn Radio Transmitter ON/OFF

You may want to turn off the radio transmitter to save power or if you are entering an area with radio restrictions (e.g., an airplane).

1 The Bluetooth icon  should appear in the task tray on the Today screen. Tap on the icon.

2 In the pop-up menu, select Turn Transmitter OFF.

3 The Bluetooth Card radio transmitter will shut off. The Bluetooth icon in the task tray will become gray, as will relevant menu 
options (e.g., Get Connected!).

4 To turn the radio transmitter back on, tap on the gray Bluetooth icon. In the pop-up-menu, select Turn Transmitter ON.

Bluetooth ActiveSync
This section explains how to use the Bluetooth ActiveSync feature. It helps you quickly and easily ActiveSync to a notebook or 
desktop computer with ActiveSync v3.x installed.

1 Tap on the Bluetooth icon . In the pop-up menu, select Bluetooth ActiveSync.

2 The next screens will vary depending on if your Bluetooth Devices folder contains any computers, and if one is chosen as 
your favorite. Please refer to the appropriate scenario:

SCENARIO #1: Your Bluetooth Devices folder contains a favorite desktop computer.

(a) When you tap Bluetooth ActiveSync, your mobile computer will automatically try to connect to your favorite computer. 

(b) The Connect To screen will appear, reporting that it is trying to connect to Wireless ActiveSync.

(c) After a successful connection is made, the status screen will report Connected. Now you are ready to synchronize files, if 
desired.

SCENARIO #2: Your Bluetooth Devices folder contains no favorite desktop computer.
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(a) When you tap on Bluetooth ActiveSync, a screen will appear that allows you to choose which computer to connect to in 
your Bluetooth Devices folder. Choose a computer from the list and tap Select, or tap Find to search for another computer.

Note: If the computer you want to connect to is not listed, tap Find to begin a search. Proceed as described in Scenario #3 on 
the next page.

(b) Your mobile computer will attempt to connect to your selected  computer.

(c) After a successful connection is made, the status screen will report Connected. Now you are ready to synchronize files, if 
desired.

SCENARIO #3: Your Bluetooth Devices folder contains no computers.

(a) When you tap on Bluetooth ActiveSync, a Bluetooth Device Search will automatically begin.

Note: You can also start the device search by tapping Find in the Bluetooth Devices screen. See Scenario #2 on page 5-21.
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(b) After the search is complete, select the computer you wish to ActiveSync with and tap Select. If the computer is not listed, 
make sure the computer id discoverable and tap Refresh to search again.

(c) After you tap Select, a service discovery phase will begin.

(d) The Connect To screen will appear, reporting that it is trying to connect to Wireless ActiveSync.

(e) After a successful connection is made, the status screen will report Connected. Now you are ready to synchronize, if 
desired.

Bluetooth LAN Access
This section explains how to use the Bluetooth LAN Access feature to quickly and easily connect to a Bluetooth-enabled LAN 
access point.

1 Tap on the Bluetooth icon. In the pop-up menu, select Bluetooth LAN Access.

2 The next screens will vary depending on if your Bluetooth Devices folder contains any access points, and if one is chosen as 
your favorite. Please refer to the appropriate scenario:

SCENARIO #1: Your Bluetooth Devices folder contains no favorite access point.
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(a) When you tap Bluetooth LAN Access, a screen will appear that allows you to choose which access point to connect to in 
your Bluetooth Devices folder. Choose an access point from the list and tap Select. 

Note: If your access point is not listed, tap Find and proceed as described in Scenario #3.

(b) Your mobile computer will try to connect to the selected access point.

(c) If your LAN requires a passkey, a screen will appear, asking for the passkey. Enter the passkey, then tap ok.

(d) After a successful connection is made, the status screen will report Connected.

(e) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #2: Your Bluetooth Devices folder contains a favorite access point.

(a) When you tap Bluetooth LAN Access, your mobile computer will automatically try to connect with your favorite access point.

(b) If your LAN requires a passkey, a screen will appear, asking for the passkey. Enter the passkey, then tap ok.
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(c) After a successful connection is made, the status screen will report Connected.

(d) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #3: Your Bluetooth Devices folder has no access points. 

(a) When you tap Bluetooth LAN Access, the mobile computer will automatically begin to search for new Bluetooth devices.

Note: You can also start the device search by tapping Find in the Bluetooth Devices screen. See Scenario #2 on page 5-21.

(b) After the search is complete, select the access point you wish to connect to. Tap Select. If the access point is not listed, tap 
Refresh to search again.

(c) After you tap Select, a service discovery phase will begin.

(d) If the LAN requires a Passkey, a screen will appear, asking for the Passkey. Enter the passkey, then tap ok.

(e) After a successful connection is made, the screen will report Connected.
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(f) Now you are ready to access your LAN for Internet access, files, etc.

OBEX
This section explains how to use the OBEX (object exchange) application to trade business cards, contacts or files with another 
Bluetooth device that supports OBEX.

Bluetooth OBEX application supports five operations:

• Exchange Business Cards
• Send a Contact
• Send a File
• Browse Remote Device
• Receive Contact or File
• Enable File Sharing

The first four operations - exchange business cards, send a contact, send a file, and browse remote device - are client-oriented. 
They involve initiating an object exchange.

The last two operations - receive contact or file and enable file sharing - are server-oriented. They involve accepting objects in 
an exchange initiated by another Bluetooth device.

Exchange Business Cards

1 Make sure both Bluetooth devices have a business card assigned to them.

Note: If each device does not have a business card assigned to it, you will not be able to exchange business cards.
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To assign a business card to your mobile computer, do the following:

• Tap on the Bluetooth icon. In the pop-up menu, tap Advanced Features | My Bluetooth Device.
• Tap on the Object Sharing tab. Under My business card, tap Assign…

• In the next screen, select your business card and tap ok. If your business card is not listed, tap on the Contacts button to 
create one.

When you return to the Object Sharing screen, tap ok.

2 Make sure the other Bluetooth device is set up to receive a contact. The device must support the OBEX Object Push profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

3 Now you are ready to exchange business cards. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | 
Exchange Business Cards.

4 If your mobile computer has no devices in the Bluetooth Devices Folder, then it will begin to search for Bluetooth devices 
nearby.
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5 Select the Bluetooth device you wish to exchange business cards with. If the device is not listed, tap Find.

6 Your mobile computer will begin to exchange business cards. After the exchange, the new business card should appear in 
your Contacts list.

Send a Contact

1 Make sure the other Bluetooth device is set up to receive a contact. It must support the OBEX Object Push server profile. 
Refer to the documentation that came with the device for instructions.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2 Now you are ready to send a contact. Go to your Contacts folder.

3 Tap and hold your stylus on the contact(s) you would like to send. In the pop-up menu, select Send Via Bluetooth.

4 If your mobile computer has no devices in the Bluetooth Devices Folder, then it will begin to search for Bluetooth devices 
nearby.
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5 Select the Bluetooth device you wish to send the contact(s) to. If the desired device is not listed, tap Find.

6 Your mobile computer will process and send the contact(s).

Send a File

1 Make sure the other Bluetooth device is set up to receive a file. It must support the OBEX Object Push server profile. Refer to 
the documentation that came with the device for instructions.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a file by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2 Now you are ready to send a file. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | Send a File.

3 If your mobile computer has no devices in the Bluetooth Devices Folder, then it will begin to search for Bluetooth devices 
nearby.
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4 Select the Bluetooth device you wish to send a file. If the desired device is not listed, tap Find.

 

5 In the next screen, tap on the file you wish to send. You can use the Folder and Type drop-down menus to search for your 
file. Also, you can scroll horizontally to view the folder, date, size, type, and location of each file.

6 Your mobile computer will send the file.

Browse Remote Device
The Bluetooth File Explorer lets your mobile computer share files with another Bluetooth device. The other device must support 
the OBEX File Transfer server profile.

This section covers the following file transfer operations:

• Prepare for file transfer
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• Send/receive file(s) or folder(s)
• Create a folder
• Delete file(s) or folder(s)
• Refresh remote view
• Connect/disconnect
• Exit the program

Note: “Local device” refers to the mobile computer you are running the OBEX from. “Remote device” refers to the Bluetooth 
device you are trying to transfer files with.

Prepare for File Transfer

1 Make sure the remote device has file sharing enabled. It must support the OBEX File Transfer server profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can enable file sharing by tapping the Bluetooth icon. 
In the pop-up menu, tap Transfer via Bluetooth | Enable File Sharing.

2 Now you are ready to browse the remote device. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | 
Browse Remote Device.

3 If your mobile computer has no devices in the Bluetooth Devices Folder that supports OBEX File Transfer, then it will begin to 
search for Bluetooth devices nearby.

4 Select the Bluetooth device you wish to browse. If the desired device is not listed, tap Find.

5 Your mobile computer will begin to establish a file sharing connection.
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6  After the devices successfully connect, the Bluetooth File Explorer will appear. Half of the screen shows contents of the 
remote device, while the other half shows contents of your device (the local device). The very bottom of the screen reports 
the connection status.

Send/Receive File(s) or Folder(s)

• Single-tap items to select them for transfer.
• Double-tap on a folders to open it and see its contents.

Complete these steps:

1 Select the file(s) or folder(s) that you wish to transfer. You can select items from only one device per transfer session.

2 There are two different ways to initiate the transfer:

• Tap on the File menu. Select Send to remote or Get from remote, as applicable. The inappropriate option should be 
gray.

• Tap on the Send to remote icon or Get from remote icon, as applicable. The inappropriate icon should be gray.
3 A screen will report the status of the transfer.

4 After the transfer, a copy of each selected item should appear in the other device.

Create a Folder
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1 Tap on the File menu. Select Remote device or Local device, wherever you want to create a folder, then tap Create remote 
folder or Create local folder, as applicable.

2 Alternatively, on the Dolphin 9500/9550, you can tap and hold your stylus on an item in either the remote or local device that 
you wish to put in a new folder. In the pop-up menu, select Create folder.

3 In the next screen, enter a name for your new folder. Tap OK.

4 The new folder should be listed under the appropriate device.

Delete File(s) or Folder(s)

1 Select item(s) that you wish to delete. You can only delete item(s) from one device at a time.

2 Tap on the File menu. Select Remote device or Local device, wherever the item(s) are located, then tap Delete remote 
item(s) or Delete local item(s), as applicable.

3 Tap and hold your stylus an item in either the remote or local device that you wish to put in a new folder. In the pop-up menu, 
select Delete folder.

4 In the Confirm screen, tap Yes.
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Refresh Remote View

1 Tap on the Device menu. Select Refresh remote view.

2 Your local device will begin to read the contents of the remote device.

3 After a few seconds, the view of the contents of the remote device will be refreshed.

Connect/Disconnect

To connect to the remote device, do the following:

1 Make sure the remote device has file sharing enabled.

2 Start the connection process by either of two methods:

• ·Tap on the Device menu. Select Connect.
• ·Tap on the Connect icon.

3 In the next screen, select the device you wish to connect to. Tap Select. Your mobile computer will attempt to connect to the 
device selected.

To disconnect from the remote device, do the following:

1 Start the disconnection process by either of two methods:

• Tap on the Device menu. Select Disconnect.
• Tap on the Connect icon.
2 Your mobile computer will disconnect from the remote device. Afterwards, no contents will be listed for the remote device.

Exit Bluetooth File Explorer

To exit the Bluetooth File Explorer, tap File | Exit. 
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 Receive Contact or File

1 Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2 The Receive Contact or File status screen will appear. Your mobile computer will wait two minutes for the contact or file.

3 After successfully connecting to the remote device, the screen will report Connected then disappear. The new contact or file 
should now be on your device.

4 If two minutes passes before you receive the item, tap Wait Again.

5 After you receive the file or contact, the “Receive Contact or File” feature is automatically disabled.

Enable File Sharing

1 Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | Enable File Sharing.

2 The Enable File Sharing status screen will appear. Your mobile computer will wait two minutes for the remote device to 
connect.

3 After successfully connecting to the remote device, the screen will report Connected.

4 If two minutes passes before you connect, tap Wait Again.

5 File sharing will be enabled until you end it by tapping Cancel.

The Dialer
This section explains how to assign a dialing prefix and use the Dialer to dial a number directly from your Contacts list. The Dialer 
makes it quick and easy to perform dial-up networking.

Note: The Dialer has been verified to work with Nokia and Ericcson phones and is known not to work with the Motorola 270c, 
NTT Docomo Paldio 633S or Sony au C413S phone. Results may vary with other phones that are not listed as being supported 
by the Bluetooth system.
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Assign a Dialing Prefix

If you have not already assigned a dialing prefix during the install process, you can do so by following these steps:

1 Go to Start | Settings | System. Tap on Dialer.

2 Select the appropriate Dialing Prefix, then tap ok.

Use the Dialer

1 To use the dialer, the mobile computer must already be connected to the Bluetooth phone. You can use the Get Connected! 
Wizard to do this. Also, the Bluetooth phone must be selected as your favorite.

2 Go to Start | Contacts.

3 Tap and hold your stylus on the contact you wish to dial to. In the pop-up menu, select Dial Contact. Alternatively, you can 
tap on Tools and select Dial Contact.

4 If you have multiple phone numbers for a contact, a screen will appear listing them, including any dialing prefix you may have 
assigned. Select the phone number you wish to dial.
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5 Your mobile computer will connect to your phone and begin dialing.

Note: The Dialer can dial a phone number containing any of the 17 following non-numeric characters:

* # + . / ! @ - \ space    A    B    C     D     T      P     W

Additionally, the following string can be included in a phone number: 

                                                                           (',')

The Dialer can not dial a phone number containing non-numeric characters other than those listed above.

HHP recommends that you follow the standard Microsoft Outlook format for phone numbers.

Get Connected Wizard
The Get Connected! Wizard guides you through a one-time setup process that prepares the mobile computer and phone for 
Bluetooth connections. The wizard varies depending on what phone you want to connect to.

Ericsson, Nokia 6210, NTT DoCoMo, Sony Phones 

1 Tap on the Bluetooth task tray icon. In the pop-up menu, select Get Connected!

2 Follow the Bluetooth “Get Connected!” Wizard. In the second screen, use the drop-down list to select your Bluetooth phone. 
The wizard will provide tailored instructions based on your selection.
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3 Follow the next screen(s) to prepare your specific phone for Bluetooth connections. You may need to do 1, 2 or all of the 
following steps:

a. Naming your Bluetooth phone

b. Setting your Bluetooth phone in Discoverable mode

c. Preparing your Bluetooth passkey.

 

4 When the search is complete, a list of the discovered Bluetooth phones will appear. Choose the phone you wish to connect 
to, and tap Select. A service discovery phase will begin, about 5-10 seconds.

5 As prompted in the next screen, prepare your phone for bonding. For instructions on setting your phone to “Bondable” or 
“Pairable” mode, refer to your phone manual. Have your passkey ready, then tap Next>.
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6 In the next screen, enter the passkey. Tap Reply.

 

7 The mobile phone may then either automatically accept the passkey or ask you to enter one. If prompted for a passkey, use 
the same one you entered on the mobile computer.

Ericsson T68/T68i only: When the phone asks you if you want to bond, select 2: Add to paired devices. Do not tap ACCEPT.

8 Tap Finish. After successfully connecting, the phone will appear in the Bluetooth Devices folder. In the Today screen, the 
Bluetooth icon will also blink. You will not need to run the Get Connected! Wizard again unless you plan to switch between 
different phones.

Note: You may also switch between different phones by assigning a new “favorite phone” in the Bluetooth Devices folder.

Motorola Timeport 270C, Nokia 3650/6310/7650/8910/8910i 

1 Tap on the Bluetooth task tray icon . In the pop-up menu, select Get Connected!

2 Follow the Bluetooth “Get Connected!” Wizard. In the second screen, use the drop-down list to select your Bluetooth phone. 
The wizard will provide tailored instructions for your phone.

Note: The screens below are for the Nokia 7650.

3 As directed in the next two screens, assign the phone a unique name and set the phone in Discoverable mode. Then tap 
Next>.

4 The mobile computer will begin to search for the phone. When the search is over, a list of the discovered Bluetooth phones 
will appear.

Choose the phone you wish to connect to, and tap Select. A service discovery phase will begin, about 5-10 seconds.
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5 The next two screens describe procedures you can only complete outside of the wizard. Read through each screen but do 
not complete the described procedures until you exit the wizard. Directions for these procedures are provided in STEP 7: 
Dial-up to Your Network, starting on the next page. The two procedures are:

Bonding with your phone - This must be completed in order to complete the Bluetooth connection and involves dial-up 
networking.

 

Automatic Connections - This procedure is optional but will make future Bluetooth connections more convenient. 

6 Continue to the last screen of the wizard and tap Finish. Now proceed to STEP 6 to complete the bonding process and, if 
desired, set up automatic connections.

 

Dial-up to Your Network
Complete the following steps to create a new Bluetooth connection. Before setting up dial-up networking, prepare yourself with 
dial-up information and other necessary settings for your office network or ISP. 
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1 Go to Start | Settings | Connections. Tap on the Connections icon. In the top field, select Internet Settings. Tap Modify… In 
the next screen, tap New…

2 In the next screen, enter a name for the dial-up connection. For the modem, select Bluetooth Phone. For the Baud Rate, 
select 115200. Tap Advanced… 

Note: Remember what you name the connection. You will need it when you start the connection.

3 The Port Settings screen will appear. If needed, tap on the TCP/IP and/or Name Servers screens to enter any necessary 
settings for your office network or ISP. Tap ok. 

4 Tap Next.

5 In the Phone number field, enter the dial-up number. Tap Next.
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